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ECDL Approved Courseware 
 

IMPORTANT - PLEASE READ 
As a condition of providing official approval for this courseware, the ECDL 
Foundation demand that the following statement appear within all approved ECDL 
courseware, produced by third party courseware providers: - 
 
""European Computer Driving Licence" and ECDL and Stars device are registered trade marks of the European 
Computer Driving Licence Foundation Limited in Ireland and other countries. Cheltenham Courseware Ltd is an 
independent entity from the European Computer Driving Licence Foundation Limited, and not affiliated with the 
European Computer Driving Licence Foundation Limited in any manner. ‘Cheltenham Courseware Ltd ECDL 
Courseware’ may be used in assisting students to prepare for the European Computer Driving Licence 
Examination. Neither the European Computer Driving Licence Foundation Limited nor Cheltenham Courseware 
Ltd warrants that the use of this ‘Cheltenham Courseware Ltd ECDL Courseware’ will ensure passing the 
relevant Examination. Use of the ECDL-F approved Courseware Logo on this product signifies that it has been 
independently reviewed and approved in complying with the following standards: 
 
Acceptable coverage of all courseware content related to the ECDL Syllabus Version 4.0. This courseware 
material has not been reviewed for technical accuracy and does not guarantee that the end user will pass the 
associated ECDL Examinations. Any and all assessment tests and/or performance based exercises contained in 
this ‘Cheltenham Courseware Ltd ECDL Courseware’ relate solely to this ‘Cheltenham Courseware Ltd ECDL 
Courseware’ and do not constitute, or imply, certification by the European Driving Licence Foundation in respect 
of any ECDL Examinations. For details on sitting ECDL Examinations in your country please contact the local 
ECDL Licensee or visit the European Computer Driving Licence Foundation Limited web site at 
http://www.ecdl.com. 
 
“Candidates using this courseware material should have a valid ECDL/ICDL Skills Card/Log book. Without such a 
skills card/Log book no ECDL/ICDL tests can be taken, no ECDL/ICDL certificate, nor any other form of 
recognition can be given to the candidate. ECDL/ICDL Skills Cards may be obtained from any accredited 
ECDL/ICDL Test Centre or from your country's National ECDL/ICDL designated Licensee". 
 
References to the European Computer Driving Licence (ECDL) include the International Computer Driving 
Licence (ICDL). ECDL Syllabus Version 4.0 is published as the official syllabus for use within the European 
Computer Driving Licence (ECDL) and International Computer Driving Licence (ICDL) certification programme." 

 
 
IMPORTANT: - Regarding ECDL courseware purchased from Cheltenham Courseware 
Ltd. Cheltenham Courseware Ltd accept no liability whatsoever arising from any 
changes which you make to this courseware, with, or without, ECDL Foundation 
approval. 
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3.1 Using the Application  
 
 

3.1.1 First Steps with Word Processing 
 
 

3.1.1.1 Open (and close) a word processing application.  
 
 

Starting Word using the Windows Start menu 
• If necessary switch on your PC and enter the necessary ID and passwords, so 

that the Windows Desktop is displayed. 
• Click on the Start icon to display the Start menu and then click on the 

Microsoft Word icon and the Word program window will be displayed. 
 

  
 
 

Closing the Word program using the Close Icon 
• Click on the Close icon displayed at the top right of the Microsoft Word 

window. 
 

 
 

Closing the Word program using a keyboard shortcut 
• Restart the Word program using the method previously outlined. Then close 

the program using the keyboard shortcut Alt+F4. 
 
 
 

3.1.1.2 Open one, several documents.  
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Opening a file 
• Start the Word program and click on the Open icon and from the dialog box 

displayed select a file called USING WORD and then double click on the file 
to open it. 
 

 
 
 

Identifying the function of the icons within the Open dialog box.  
• Click on the Open icon. Make sure that you understand the function of each 

of the following icons displayed along the top of the Open dialog box.  
 
Remember that you can use the 'What is this Help'. To do this click on the 
Question Mark icon at the top-right of the dialog box, and then click on an 
item you do not understand. A popup box is displayed containing help on the 
item you click on. Try it! 
 

 
 

 
 

 
 

 
 

 
 

 
 
 

Selecting a continuous block of files to open 
• Click on the Open icon, which will display the Open dialog box. 
• Click on the first file of the block you wish to select, (in this case select the 

first file displayed in the list) and then while depressing the Shift key, click 
on the last file of the required block (in this case click on the sixth file in the 
list). When you release the Shift key the entire block will remain selected. 

• Click on the Open button and all the selected files will open. 
• Close all open files.  To do this, hold down the Shift key whilst clicking on the 

File drop down menu and then select the Close All command. 
 
 

Selecting multiple files (to open) which are not in a continuous block 
• Click on the Open icon, which will display the Open dialog box. 
• Click on the first file which you wish to select (in this case the first file on the 

list) and while keeping the Ctrl key depressed, click on the other files which 
you wish to select (click on a few at random to illustrated the principle). 
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When you release the Ctrl key, the selected files will continue to be 
highlighted. 

• Click on the Open button and all the selected files will open. 
• Close all open files. 

  
 
 

3.1.1.3 Create a new document (based on default, other available 
template). 
 
 

Creating a new document based on the default template 
• Click on the New icon and a new blank document will be displayed on the 

screen. This document will be based on the default template within Word. 
 

 
• Type in your name. 
• To save the file click on the Save icon, enter a file name (in this case called 

STARTING), and then click on the Save button. 
• Close the file. 
 
 

Creating a new document based on another template 
• From the File menu select New to display the New Document task pane. 
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• You will see a range of options displayed within the Task Pane. 
 

 
 
• In this case we want to create a professional looking memo. Within the New 

from template section, click on General Templates and the following 
dialog will be displayed. 
 

 
 

• Click on the Memos tab and select the Professional Memo icon which 
displays the following. 
 

 
 
• Clicking on the OK button will display the outline of a memo on your screen, 

which you can adapt. 
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• Where the text Company Name Here is displayed, enter a fictitious 
company name. 

• Experiment with customising the rest of the menu. 
• Save the file as MY MEMO, and then close the file. 
 
 
 

3.1.1.4 Save a document to a location on a drive.  
 
 

Saving a file to a diskette 
• Open a file called USING WORD. Click on the File drop down menu and 

select the Save As command. A dialog box will be displayed similar to that 
illustrated. 
 

 
 
• Click on the down arrow to the right of the Save in section of the dialog box, 

which will display a drop down menu, as illustrated. 
 

 
 
• Select the 3 1/2 Floppy (A:) icon. 
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• Enter a file name (in this case MY MEMO 1) and then click on the Save 
button. 

 
 
 

Creating a new folder in which to save your document 
• Click on the File drop down menu and select the Save As command. Word 

will remember the last place you saved to (i.e. the floppy disk) and this 
location will be displayed in Save As dialog box. 

• Click on the Create New Folder icon, displayed within the Save As dialog 
box. This will display the New Folder dialog box.  
 

 
 
• Enter the name of the new folder (in this case MY DATA), and then click on 

the OK button. This folder will then be automatically displayed within the 
dialog box. 

• Click on the Save button to save the file. 
 
 
 

3.1.1.5 Save a document under another name.  
 
 

Saving using "Save As" 
• From the File menu choose Save As command and enter a new file name (in 

this case MY MEMO 2) 
• Save the file. 
 
 
 

3.1.1.6 Save a document in another file type such as: text file, Rich Text 
Format, HTML, template, software specific file extension, version 
number. 
 
 

Saving a file in a format other than Microsoft Word format 
• From the File drop down menu, click on the Save As command. 
• Click on the My Documents button to reset the default location to the My 

Documents folder. 
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• Enter a file name, in this case name (in this case MY MEMO 3). 
• Click on the down arrow to the right of the Save as type: box, and select the 

type of file format which you wish to save the file as (in this case Rich Text 
Format). 
 

 
 
• Click on the Save button to save it in the required format.  
 
• Experiment with saving the file in other formats such as: 

- a text file 
- an HTML format 
- a template format 
- as a file formatted to be compatible with an earlier version or Word (such as 
Word 6) 
- as a file formatted for use with a completely different application, such as 
WordPerfect. 

 
 
 

Saving a file using a software specific file extension 
• In some cases you may wish to specify a file extension name. For instance, 

you may want to save a database file, not as a text only file, which by default 
will have a file name extension of .TXT, but as a text file using a .CSV file 
name extension. To do this we will use the Save As option, select the Plain 
Text option, and enter a name along with the file name extension, such as 
CONTACTS.CSV. 
 

 
 
When you click on the Save option you may see the following dialog box. 
Select Windows (Default) and then click on the OK button. 
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• Save any open files and close the Word program. 
 
 
 

3.1.1.7 Switch between open documents.  
 
 

Switching from one open document to another one (using the Taskbar) 
• Start Microsoft Word. 
• Open any three files. 
• To change from one document to another, simply click on the required 

document, as displayed within the Taskbar at the bottom of your Windows 
screen. 
 

 
 
• You can also experiment with using the Window drop down menu to switch 

between documents. 
 

 
 
 
 
 

3.1.1.8 Use available Help functions.  
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Displaying the Office Assistant Help 
• The Office Assistant is displayed by default. If the assistant has been 

hidden and you wish to reactivate it, select Show the Office Assistant from 
the Help menu. 
 

  
 
 

Hiding the Office Assistant 
• Right click on the Office Assistant and from the menu displayed, click on the 

Hide command. 
 

 
• Before continuing, re-display the Office Assistant. 
 
 

"What is this" Help 
• Within many dialog boxes you will see a question mark symbol in the top-

right corner of the dialog box. For instance click on the Format drop down 
menu, select the Font command and this will display the Font dialog box with 
this sort of help enabled. Not all dialog boxes have this feature however. To 
use "What is this", click on the question mark and then click on the item in 
the dialog box which you do not understand. 
 

 
 
• In the example shown we have clicked on the Shadow check box within the 

Font dialog box, and as you can see help is displayed relating to the Shadow 
option! 
 

 
 

• Experiment! 
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3.1.1.9 Close the document.  
 
 

Closing a document in Word 
• Click on the Close icon displayed at the top-right of the document window. 

Be sure to click on the Close Window icon, (as opposed to the Close icon). 
 

 
 

• Close all documents before continuing. 
 
 
 

3.1.2 Adjust Settings  
 
 

3.1.2.1 Change between page view modes.  
 
 

Viewing a document using different modes 
• Open a file called LOOK AT ME. 
• Experiment with clicking on the View drop down menu and viewing the effect 

of selecting various views such as: 
- Normal 
- Web Layout 
- Print Layout 
- Full Screen 
 

 
 

• As you will see Print Layout gives a good impression of how the printed page 
will look. The normal view can display very strange looking results! 

• When you have finished re-view the document using the Print Layout view. 
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3.1.2.2 Use magnification/zoom tool.  
 
 

Zooming a document using the Zoom icon 
• Use the Zoom icon on the Standard toolbar to quickly zoom to certain 

settings. Click on the down arrow next to the Zoom icon to display a drop 
down list of pre-set screen zoom values. 
 

 
 

• Experiment using high and then low zooms. 
• When you have finished experimenting, reset the value to Page Width 

setting. 
 
 
 

3.1.2.3 Display or hide built-in toolbars.  
 
 

Displaying or hide a toolbar 
• To display a toolbar, select the Toolbars command from the View menu to 

display the Toolbars drop down menu. A list of toolbars is displayed which 
includes: Standard, Formatting, Borders, Database and Drawing. Choose the 
Toolbar you want to display or hide by clicking on it from the list. 
Experiment! 
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• Before continuing, make sure that only the Standard and Formatting 
toolbars are displayed. 

 
 
 

3.1.2.4 Display or hide non-printing characters.  
 
 

Displaying non-printing characters 
• Click on the Show/Hide icon, located within the Standard Toolbar and view 

the effect on the document. 
 

 
 
• Before continuing, re-click on the Show/Hide icon located within the 

Standard Toolbar to hide the non-printing characters. 
 
 
 

3.1.2.5 Modify basic options/preferences in the application: user name, 
default directory/ folder to open, save documents. 
 
 

Modifying preference options within Word 
• Click on the Tools drop down menu and select the Options command which 

will display the Options dialog box.  
 
• To examine the User Information: Click on the User Information tab 

within the dialog box, and see the sort of information which is stored here. 
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• Examining the default folder: Click on the File Locations tab within the 

dialog box. Select Documents in the File types sections. Which folder is 
currently set as the default document folder? The default folder is the folder 
which will, by default, be displayed within the Open or Save dialog boxes in 
Word. 
 

  
 

• When you have finished examining the options available, close any open 
dialog boxes, without saving any changes which you may have made. 

• Close Microsoft Word before continuing. 
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3.2 Main Operations 
 
 

3.2.1 Insert Data  
 
 

3.2.1.1 Insert text.  
 
 

Inserting a word 
• Open a file called INSERT DATA. 
• Insert the word Microsoft before the word 'Word' at the beginning of the 

document. 
 
 

Inserting a new paragraph 
• Click just after the end of the last word within the document. Press the Enter 

key two times. Type in a short paragraph of text (about why you are learning 
how to use a word-processor). 

 
 
 

3.2.1.2 Insert special characters and symbols.  
 
 

Inserting special symbols 
• Click just after the end of the last word within the document. Press the Enter 

key two times. Click on the Insert drop down menu and select the Symbol 
command. This displays the Symbol dialog box. You can select a symbol and 
then click on the Insert button to insert the symbol into the document. 
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• In this case insert the Copyright character. 
 

 
 
• Click on the Close button. 
• Next to this type in your full name. 
• Save the document and then close the document. 
 
 
 

Using AutoCorrect to insert symbols 
• Open a file called AUTOCORRECT. 
• Try entering the following and see what happens … 

(c)  
(r)  
(tm) 

• Save the changes to your document and close the file. 
 
 
 

3.2.2 Select Data  
 
 

3.2.2.1 Select character, word, line, sentence, paragraph or entire body 
text.  
 
 

Selecting a character 
• Open a file called SELECT DATA. 
• Click just in front of the character you want to select (in this case in front of 

the first character in the blue paragraph). 
• Press the Shift key (and keep it pressed). 
• Press the right arrow key. 
• Release the Shift key. 

 
The screen will resemble that below. 
 

 
 

• Now that we have selected the character, we will apply a change to the 
selected character. Click on the down arrow to the right of the Font Colour 
icon and clicking on a colour. That colour will then be applied to the selected 
character. 
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Selecting a word 
• Double click on the second word in the blue paragraph, as illustrated. Now 

the word is selected, apply a different font colour to the selected word. 
 

 
 
 

Selecting a line 
• Move the mouse pointer to the left of the second line within the blue 

paragraph and wait until the mouse pointer changes from an I bar to an 
arrow pointing upwards and to the right. You are now in the “Selection Bar”, 
a hidden screen element. Click once with the mouse button to select the line, 
as illustrated. 
 

 
• Now the line is selected, apply a different font colour to the selected line. 

 
 

Selecting a sentence 
• Click within the second sentence of the second paragraph. Depress the Ctrl 

key and then click within the sentence, to select the sentence.  
 

 
 
• Now the sentence is selected, apply a different font colour to the selected 

sentence. 
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Selecting a paragraph 
• Click within the paragraph starting with the words ' To select a character '. 
• Click three times to select the paragraph, as illustrated. 

 

 
• Now the paragraph is selected, apply a different font colour to the selected 

paragraph. 
 
 

Selecting all text 
• Experiment with selecting all the text within the document by pressing 

Ctrl+A. 
• Save and close the document. 

 
  

 

3.2.3 Edit Data  
 
 

3.2.3.1 Edit content by inserting new characters, words within existing 
text, over-typing to replace existing text. 
 
 

Inserting text 
• Open a file called EDIT DATA. 
• Within the second line, click in front of the word star. 
• Type in the letter a. 
• Press the spacebar to insert a space. The sentence should now read  

'The Sun is a star'. 
 
• Within the first line, click in front of the word 'word'. 
• Type in the word Microsoft. 
• Press the spacebar to insert a space. The sentence should now read 'A good 

example of an application program is Microsoft Word'. 
 
 

Modifying existing text 
• Double click on the word David in the last line (to select it). 
• Replace the selected name with your first name. 
 
 
 

3.2.3.2 Use the undo, redo command.  
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Using Undo to reverse your last actions 
• Click on the Undo button on the Standard toolbar. You should see the name 

David reappear! 
 

 
 
 

Repeating a command, action, or typing 
• Click on the Redo button on the Standard toolbar. You should see your 

name reappear. 
 

 
• Save the file changes and then close the file. 
 
 
 

3.2.4 Duplicate, Move, Delete  
 
 

3.2.4.1 Duplicate text within a document or between open documents.  
 
 

Copying text within a document 
• Open a file called DUPLICATE MOVE DELETE 01. 
• Click three times within the first paragraph to select it. 
• Click on the Edit drop down menu and select the Copy command. 
• Move to the end of the document and click once. 
• Click on the Edit drop down menu and select the Paste command. 
 
 

Copying text from one document to another 
• Click three times within the first paragraph to select it. 
• Click on the Edit drop down menu and select the Copy command. 
• Open a second document called DUPLICATE MOVE DELETE 02. 
• Within this second document, click at the position within the document to 

where you wish to copy the selected text. 
• Click on the Edit drop down menu and select the Paste command. 
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3.2.4.2 Move text within a document or between open documents.  
 
 

Moving text within a document 
• Redisplay the first document called DUPLICATE MOVE DELETE 01 (by 

clicking on its icon displayed along the bottom of your screen). 
• Select the paragraph formatted using Arial Bold text. 

 

 
 
• Click on the Edit drop down menu and select the Cut command. 
• Click at the end of the document. 
• Click on the Edit drop down menu and select the Paste command. 
 
 

Moving text from one document to another 
• Select the paragraph formatted using Arial Bold text. 

 
 
• Click on the Edit drop down menu and select the Cut command. 
• Redisplay the second document called DUPLICATE MOVE DELETE 02 (by 

clicking on its icon displayed along the bottom of your screen). 
• Click at the position within the document to where you wish to move the 

selected text. 
• Click on the Edit drop down menu and select the Paste command. 
• Save your changes and close both files. 
 
 
 

3.2.4.3 Delete text.  
 
 

Deleting a character 
• Open a file called DELETE. 
• Place the insertion point to the left of the very first character within the 

document and press Delete.  
 
 

Deleting a word 
• Double-click within the second word in the document and press the Delete 

key. 
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Deleting a line 
• Select a line within the paragraph explaining how to delete a line by moving 

the mouse pointer in the left-hand margin and clicking once. 
• Press the Delete key. 
 
 

Deleting a sentence 
• Select a sentence within the paragraph explaining how to delete a sentence.  
• Depress the Ctrl key and click once to select the sentence. 
• Press the Delete key. 
 
 

Deleting a paragraph 
• Select the paragraph explaining how to delete a paragraph (triple click to 

select the paragraph). 
• Press the Delete key. 
 
 

Deleting a block of text 
• Experiment with selecting blocks of text within the last paragraph in the 

document (by dragging the mouse pointer over the text with the left mouse 
button depressed). Once the text is selected press the Delete key. 

• Save your changes and close the file. 
 
 
 

3.2.5 Search & Replace  
 
 

3.2.5.1 Use the search command for a specific word, phrase. 
 
 

Finding text in a document 
• Open a file called SEARCH AND REPLACE. 
• Click on the Edit drop down menu and select the Find command to display 

the Find and Replace dialog box. 
• Type the text you wish to find in the Find what text box, in this case the 

word Excel. 
 

 



PAGE 26 - ECDL MODULE 3 WORKBOOK (USING OFFICE XP) 

FOR USE AT THE LICENSED SITE(S) ONLY 
© Cheltenham Courseware Ltd. 1995-2005 www.cheltenhamcourseware.com 

 
• Click on the Find Next button to find the next occurrence of the text you are 

looking for. You will need to click on the Find Next button a few times to find 
all occurrences of the word Excel. Close the Find and Replace dialog box. 

 
 
 

3.2.5.2 Use a simple replace command for a specific word, phrase.  
 
 

Finding and replace text in a document 
• Click on the Edit drop down menu and select the Replace command to 

display the Find and Replace dialog box. 
• Type the text you wish to find and replace in the Find what text box, in this 

case the word Excel. 
• Type the replacement text in the Replace with text box, in this case 

Microsoft Excel. 
 

 
 
• Click on the Replace All button and this will replace all occurrences of the 

word as specified. 
• Close the Find and Replace dialog box. 
• Save your changes and save the file. 
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3.3 Formatting  
 
 

3.3.1 Text Formatting  
 
 

3.3.1.1 Change text appearance: font sizes, font types.  
 
 

Changing the font size or type 
• Open a file called TEXT FORMATTING 01. 
• Select the first line of text, as illustrated. 

 

 
 
• Apply a different font to the selected text, and also make the font size larger, 

using the Font and Font Size icons. 
 

  
 
 
 

3.3.1.2 Apply text formatting such as: bold, italic, underline. 
 
 

Formatting selected text as bold or italic or Underlines 
• Select the first line of text as before and format the text as Bold, Italic and 

underlined using the icons in the Formatting toolbar. 
 

 
 
 
 

3.3.1.3 Apply subscript, superscript to text. 
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Applying subscript or superscript formatting 
• Select the 2 in the line containing the equation E=MC2. 
• From the Format menu, choose the Font command. The Font dialog box is 

displayed.  
• From within the Effects section of the dialog box, select the Superscript 

command. 
 

 
 
• Click on the OK button to close the Font dialog box. 
• Select the 2 in the line containing the equation H2O. 
• From the Format menu, choose the Font command. The Font dialog box is 

displayed.  
• From within the Effects section of the dialog box, select the Subscript 

command. 
• Click on the OK button to close the Font dialog box. 
• The text should now look like this. 

 

 
 
 
 

3.3.1.4 Apply case changes to text.  
 
 

Changing the text case 
• Select the first line of text. Click on the Format drop down menu and select 

the Change Case command. From the dialog box displayed, select the 
required case, (in this case UPPERCASE) and then click on the OK button. 
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3.3.1.5 Apply different colours to text.  
 
 

Applying colours to selected text 
• Select the first line of text again. 
• Click on the down arrow next to the Font Colour icon, which will display a 

drop down dialog box. 
• Click on the colour you wish to apply (in this case Red). De-select the 

selected text to see the effect of your formatting changes! 
 

 
 
 

Applying different background colours to selected text 
• Select the last paragraph of text (by triple clicking within the paragraph). 
• Click on the Format drop down menu, and select the Borders and Shading 

command. 
• Within the dialog box displayed, select the Shading tab. 
• Select the required colour (in this case choose a yellow colour) and then click 

on the OK button. 
 

 
 
 
 

3.3.1.6 Copy formatting from a piece of text to another piece of text. 
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Copying formatting using the Format Painter. 
• Select some text which has been previously formatted. 
• Click on the Format Painter icon. You will notice that the mouse pointer 

shape has changed to the shape of a small painting brush. 
• Select the text to which you wish to copy the formatting, and when you 

release the mouse button (and de-select the newly selected text) you will see 
that the formatting applied to the first block of text has been copied to the 
newly selected text. 

• Save your changes and close the file. 
 
 
 

3.3.1.7 Apply an existing style to a word, a line, a paragraph. 
 
 

Applying a style 
• Open a file called TEXT FORMATTING 02. 
• If necessary change to ''Print Layout' view. 
• Follow the instructions within the document and apply different styles.  

 
To apply a style you click on the down arrow to the right of the Style box to 
display the Style List box, then select a style and it will be applied to the 
selected text. 
 

 
 
 
 

3.3.1.8 Use automatic hyphenation.  
 
 

Setting automatic hyphenation 
• If necessary change to 'Print Layout' view. 
• To see how hyphenation has been set on your PC, click on the Tools drop 

down menu and select the Language command. From the sub-menu 
displayed select the Hyphenation command. This will display the 
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Hyphenation dialog box. 
 

 
 
• To automatically hyphenate a document, click on the "Automatically 

hyphenate document" check box. What changes do you see when you click 
on the OK button? 
 

 
 

• Close the dialog box and continue. 
 
 
 

3.3.2 Paragraph Formatting 
 
 

3.3.2.1 Insert or remove paragraph marks.  
 
 

Inserting a paragraph mark 
• Click just below the line which talks about formatting using Heading 1. 
• Insert a few extra paragraph marks by pressing the Return (Enter) key. 
 
 

Removing a paragraph mark 
• Click just below the line which talks about formatting using Heading 2. 
• Remove the paragraph mark by pressing the Del key. There should now be 

no empty lines displayed between the last two lines in the document. 
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3.3.2.2 Insert, remove soft carriage return (line break) marks. 
 
 

Inserting a soft carriage return (line break) 
• In the line which talks about formatting using Heading 1, click just before the 

word 'this'. 
• Press the Enter key while depressing the Shift key.  
• Click on the Show/Hide icon to display the line break character, and you 

should see the following. 
 

 
 
• Re-click on the Show/Hide icon to hide the display the line break character. 
 
 

Removing a soft carriage return (line break) 
• Use normal deletion techniques to delete the line break symbol. 
• Use the Undo icon to reverse this deletion. 
 
 
 

3.3.2.3 Align text left, centre, right, justified.  
 
 

Aligning text in a document 
• Click within the first line of text and centre the text using the alignment icons 

located on the Formatting toolbar. 
 

 
 
 
 

3.3.2.4 Indent paragraphs left, right, first line, hanging.  
 
 

Using the Indent icons 
• Indent the first paragraph of text using the Increase Indent icon on the 

toolbar. 
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Indenting a hanging paragraph 
• Click with the second paragraph. From the Format menu, select the 

Paragraph command to display the Paragraph dialog box. 
• If not already displayed, select the Indents and Spacing tab. You can see 

the following options: 
 

 
 

• Apply a hanging indent. 
 

 
 

3.3.2.5 Apply single, double line spacing within paragraphs.  
 
 

Adjusting line spacing in a document 
• Click within the second paragraph. From the Format menu, click on the 

Paragraph command to display the Paragraph dialog box. 
• Within the Line Spacing section of the dialog box, set the line spacing to 

Double. 
• Examine the other options available. 

 

 
 
• Click on the OK button to apply your changes. 
• Save your changes and close the file. 
 
 
 

3.3.2.6 Apply spacing above, below paragraphs.  
 
 

Controlling spacing above and below paragraphs 
• Open a file called PARAGRAPH FORMATTING 01. 
• Click within the second paragraph. Click on the Format drop down menu and 

select the Paragraph command. This will display the Paragraph dialog box. 
• Within the dialog box, change the Spacing section of the dialog box, modify 

the spacing Before and After, as required. 



PAGE 34 - ECDL MODULE 3 WORKBOOK (USING OFFICE XP) 

FOR USE AT THE LICENSED SITE(S) ONLY 
© Cheltenham Courseware Ltd. 1995-2005 www.cheltenhamcourseware.com 

 

 
 

• Experiment for a while and observe the effects! 
• Save your changes and close the file. 

 
 
 

3.3.2.7 Set, remove and use tabs: left, centre, right, decimal.  
 
 

Setting or change tabs using the Ruler 
• Open a file called TABS. 
• Click on the Show/Hide icon so that you can see the tab stops displayed. 
• To move the tab stops select all the text and drag the Tab stops (as displayed 

within the Word Ruler) to the left or right. 
 

 
• Click at the end of the document and experiment with inserting tab spaces. 

Experiment with entering text into these tab spaces. 
• Save your changes and close the file. 
 
 
 

3.3.2.8 Apply bullets, numbers to a single level list. Remove bullets, 
numbers from a single level list. 
 
 

Applying bullets to a list using the Bullets icon 
• Open a file called PARAGRAPH FORMATTING 02. 
• Select the list of Countries. 
• Click on the Bullets tool within the Formatting toolbar. 

 

 
 
 

Removing bullet formatting from a list 
• Select the list of Cities. 
• Click on the Bullets icon on the Formatting toolbar. 
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Adding numbering to a list using the Numbering icon 
• Select the list of Continents. 
• Click on the Numbering icon from the Formatting toolbar. 

 

 
 
 
 

3.3.2.9 Change the style of bullets, numbers in a single level list from 
built-in standard options.  
 
 

Applying alternate bullet formatting to a list 
• Select the list of Countries. 
• From the Format menu select Bullets and Numbering, to display the 

Bullets and Numbering dialog box. 
 

 
 
• The Bulleted option tab should be displayed, if not, select it. A list of 

different bulleted styles will appear. Select a bullet style from the Bulleted 
folder (just experiment for a while!). 

 
 

Adding alternative numbering styles to a list 
• Select the list of Continents. 
• From the Format menu select Bullets and Numbering, which will display 

the Bullets and Numbering dialog box. 
• Click on the Numbered tab. A list of different numbered styles is displayed, 

contained in small rectangular boxes. Select the numbering format which you 
require (just experiment for a while!). 

• Save your changes and close the file. 
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3.3.2.10 Add a top and bottom border, box border and shading to a 
paragraph.  
 
 

Adding a border using the Border icon 
• Open a file called BORDERS. 
• Click within the main body of text. Click on the Outside Border icon and you 

should see a border displayed around the text. 
 

         
 
 

Adding a Page Border 
• From the Format menu, choose Borders and Shading. The Borders and 

Shading dialog box appears with the Borders folder displayed. Select the 
Page Border tab and from the Setting section of the dialog, select the 
required effect, i.e. Box, Shadow, 3-D etc. 
 

 
 
You can select from a range of line styles. 
You can select from a range of colours. 
You can select from a range of line widths. 
You may also select a range of Art effects. 
 

• Experiment for a while! 
• Save your changes and close the file. 
 
 

Adding shading 
• Open a file called SHADING. 
• Select the document title. 
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• Select Borders and Shading from the Format menu. The Borders and 
Shading dialog box is displayed. Select the Shading tab. 
 

 
 
• Experiment with applying different shading options to the selected text. 
• Save your changes and close the file. 
 
 
 

3.3.3 Document Formatting  
 
 

Document Formatting Options 
• Open a file called DOCUMENT FORMATTING. Most formatting options 

within Word are found under the Format drop down menu. The document 
setup options are located under the File drop down menu and accessed via 
the Page Setup command. Take some time to examine the options 
available, but do not make any changes. 
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3.3.3.1 Change document orientation – portrait or landscape. Change 
page size.  
 
 

Setting the page orientation 
• To select the paper orientation, click on the Portrait or Landscape buttons 

in the Orientation section. Change the page orientation to Landscape. 
 

 
 

• View the document in by clicking on the Print Preview icon. 
• Reset the page orientation back to Portrait. 
 
 
 

3.3.3.2 Change margins of entire document, top, bottom, left, right.  
 
 

Setting margins using the Page Setup command 
• From the File menu choose the Page Setup command and the Page Setup 

dialog box is displayed. 
• If it is not already displayed, select the Margins tab. 

 

 
 
• Double the size of the bottom margin. 
 
 
 

3.3.3.3 Insert, delete a page break in a document.  
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Inserting and deleting a hard (manual) page break 
• Click between the paragraphs dealing with Font and Paragraph formatting 

and then press Ctrl+Enter to insert a page break. Change to Normal view 
(by clicking on the View drop down menu and select the Normal view 
command) and the page break will be as illustrated below. 
 

 
 
• To delete the page break place the insertion point below the hard page break 

(the dotted line) and press BACKSPACE. 
• Click on the Undo icon to put the page break back into the document. 
• Click on the View drop down menu and select the Print Layout view. 
 
 
 

3.3.3.4 Add, modify text in Headers, Footers. 
 
 

Creating a header or footer 
• From the View menu, select the Header and Footer command and the 

Header and Footer toolbar is displayed, as illustrated. 
 

 
 
• Outlines of the Header and Footer text entry boxes appear at the top and 

bottom of the page. 
 

 
 

  
 

• Make sure that the Header is displayed. You can change between Header 
and Footer by clicking on the Switch Between Header and Footer button. 
Insert the text for the Header (in this case enter your name). 
 

 
 
• Switch to the Footer area. Remember that you can change between Header 

and Footer by clicking on the Switch Between Header and Footer button. 
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Insert the text for the Footer (in this case enter your company or 
organisation). 
 

 
 
• When you have entered your Header and Footer text, click on the Close 

button on the Header and Footer toolbar. 
• Click on the Print Preview icon to see the effects of inserting a header and 

footer. You should find that these automatically appear on every page. 
 
 

Modifying a header or footer 
• From the View menu, select the Header and Footer command. Edit the 

text in the footer area so that you also include today's date. 
 
 
 

3.3.3.5 Add fields in Headers, Footers: date, page number information, 
files location.  
 
 

What is Word Fields? 
• Fields are codes which can be inserted into a Word document to automate 

your work in some way, or make the use of Word more effective. For 
instance, you can use fields to automatically generate a table of contents at 
the start of a long document, or use different fields to insert the current time 
or date. In some cases you must consciously insert a field code, in other 
cases Word automatically inserts a field code into the document for you. You 
will often need to open the Field dialog box, to really get the best effect from 
using Fields. This is opened by selecting the Field command from the Insert 
menu. 
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• Open this dialog box now and examine some of the options which are 
available. Make sure that you find out how you would insert the date, page 
numbering and file storage location information. Experiment for a while! 

 
 

Using the Header and footer toolbar. 
• As well as inserting Word fields via the Field dialog box, remember that you 

can also use the options contained with the Header and Footer toolbar. 
 

 
• Clicking on the Insert AutoText button will display further options! 

 

 
 
• Experiment and investigate some of these options! 
• Save your file and close the document. 
 
 
 

3.3.3.6 Apply automatic page numbering to a document.  
 
 

Numbering pages within a document 
• Open a file called PAGE NUMBERING. 
• Try viewing the document in Print Preview view (click on the Print 

Preview icon in the toolbar). As you can see there is no header or footer and 
no page numbering. 

• Click on the Close icon in the Print Preview toolbar to switch back to Print 
Layout view. 

• Click on the Insert drop down menu and select the Page Numbers 
command to display the Page Numbers dialog box.  

• In this case make sure that Top of Page (Header) is selected and use the 
alignment section of the dialog box to centre the heading. 
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• Click on the OK button and the document will now have page numbers 

inserted. Try viewing the document in Print Preview view (click on the Print 
Preview icon in the toolbar). Switch back to Print Layout view. 

• Save the file and close the document. 
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3.4 Objects  
 
 

3.4.1 Tables  
 
 

3.4.1.1 Create a table ready for text insertion.  
 
 

Creating a table using the Insert Table icon 
• Open a document called TABLES. 
• As instructed within the document, click below the first line of text and create 

a table 'which contains 5 rows and 3 columns' To do this click on the 
Insert Table icon and drag the mouse over the grid to select the number of 
rows and columns you require. 
 

 
 
• The screen will change as illustrated. 

 

 

 
 

 
 
 
 

3.4.1.2 Insert, edit data in a table.  
 
 

Entering data into a table 
• Click on the first cell within the table. 
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• Enter your first name. Move to all the other cells in the table and enter a 
different name in each cell. To move from cell to cell you can use the Tab 
key. 

 
 
 

3.4.1.3 Select rows, columns, cells, entire table.  
 
 

Selecting parts within a table, using the Table drop down menu 
• Experiment with selecting rows, columns and the entire table. To do this click 

on the Table menu, click on Select and from the submenu, select the 
required item, Table, Column, Row or Cell. 
 

 
 
 
 

3.4.1.4 Insert and delete rows and columns.  
 
 

Inserting a column or row into the table 
• Select the second column within the table and from the Table menu, select 

the Insert Columns command. Look at what happens and where the column 
is inserted. 

• Select the second row within the table and from the Table menu, select the 
Insert Rows command. Look at what happens and where the row is 
inserted. 

 
 

Deleting a column or row within a table 
• Delete the first row and first column within the table. To do this select the 

row or column and then from the Table menu, choose Delete Columns or 
Delete Rows. 

 
 
 

3.4.1.5 Modify column width, row height. 
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Specifying row height 
• Select the top row. 
• Click on the Table drop down menu and select the Table Properties 

command. The Row tab should be selected. Click on the Specify Height 
check box, and enter a value next to this (experiment with different values). 
Click on the OK button to apply the change. 

 
 

Specifying column width (the long way) 
• Select the first column. 
• Click on the Table drop down menu and select the Table Properties 

command. The Column tab should be selected. Click on the Preferred 
width check box and enter a value next to this (experiment with different 
values). Click on the OK button to apply the change. 

 
 

Specifying column width (the easy way) 
• Move the mouse pointer to the vertical border, to the right of the column of 

which you wish to change the width. You will notice that the mouse pointer 
shape changes when you are pointing exactly at the vertical border. When 
the mouse shape changes, depress the mouse button and drag to the left or 
right to change the width of the column. When you release the mouse button 
the change will be applied (experiment with using this technique). 

 
 
 

3.4.1.6 Modify cell border width, style and colour 
 
 

Adding a border to a table 
• Click once within your table. 
• Click on the Table drop down menu and then click on the Select command. 

From the sub-menu displayed, click on Table. This will select the entire table 
for you. 
 

 
 
• Once the table is selected click on the down arrow next to the Border icon 

(on the Formatting toolbar) to select and apply border formats to your table. 
De-select your table to view the results. Experiment with adding a border of 
your choice. 
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Specifying a border width, style and colour. 
• Click on the Format drop down menu and select the Borders and Shading 

command. 
• If necessary, select the Borders tab of the dialog box. 

 

 
 
• Select the style as required. You can use the scroll bars within this part of the 

dialog box to display a wide range of options as illustrated. 
 

 
 

• Select the width as required. You can use the scroll bars within this part of 
the dialog box to display a wide range of options as illustrated. 
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• Select a colour as required from the Colour section of the dialog box. 
• Experiment and investigate the options available. 
 
 
 

3.4.1.7 Add shading to cells. 
 
 

Applying shading to cells within a table. 
• Select particular cells within a table, or select the entire table. 
• Click on the Format drop down menu and select the Borders and Shading 

command. 
• If necessary, select the Shading tab of the dialog box. 

 

 
 

• Select the required colour, and then click on the OK button. 
• Experiment with adding a colour of your choice (but make sure that the text 

is still readable!) 
• Save the file and then close the document. 
 
 
 

3.4.2 Pictures, Images and Charts  
 
 

3.4.2.1 Insert a picture, an image, a chart into a document. 
 
 

Inserting Clipart 
• Open a document called PICTURES IMAGES CHARTS 01. 
• If nessesary change to 'Print Layout' view. 
• Make sure that the Drawing toolbar is displayed. If it is not, then click on 

the Drawing icon displayed within the Standard toolbar. 
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• Click at the location where you wish to insert the clipart picture (in this case 

click below the line of text as instructed within the document). 
• Click on the Insert Clip Art icon, located in the Drawing toolbar. You will 

see the Clip Art options displayed to the right of your screen. 
 

 
 

• In the Search section enter a search word such as computers. Then click on 
the Search button. Matching Clip Art will be displayed, as illustrated. 
 

 
 
• If necessary use the scroll bars to display the required picture and then click 

on the picture which you wish to insert. 
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• Try this now! 
 
 

Inserting a picture held as a file on your hard disk 
• Click towards the bottom of the document. 
• Click on the Insert drop down menu and select the Picture command.  
• From the submenu displayed, select From File. 

 

 
 

• Use the dialog box which is displayed to select the required file (in this case 
select a file called COMPUTER IMAGE).  
 
You may have to select a different drive or folder if the file is stored in a 
different location. You will see a preview of the selected file, as illustrated. 
 

 
 
• Once you have selected the required file, click on the Insert button and the 

image will be displayed as illustrated. 
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Inserting a chart into a document 
• Click towards the bottom of the document and press the Enter key a few 

times to give yourself some space. 
• Click on the Insert drop down menu and select the Picture command. From 

the submenu click on Chart. 
 

 
 

• A chart will be inserted into the document. 
 

 
 
 
 

3.4.2.2 Select a picture, image, chart in a document. 
 
 

Selecting a graphic 
• Click once on the picture at the top of the document and the selected picture 

is now surrounded by 8 'handles' (small black squares) as illustrated. 
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3.4.2.3 Duplicate a picture, image, chart within a document, between 
open documents.  
 
 

Copying a graphic within a document 
• Select the picture of the green racing car by clicking on it once. 
• Click on the Edit drop down menu and select the Copy command. 
• Click within the document at the location where you wish to copy the graphic. 
• Click on the Edit drop down menu and select the Paste command. 
 
 

Copying a graphic between open documents 
• Select the picture of the green racing car by clicking on it once. 
• Click on the Edit drop down menu and select the Copy command. 
 
• Open a second Word called PICTURES IMAGES CHARTS 02. 
 
• Click within the second document at the location where you wish to copy the 

graphic. 
• Click on the Edit drop down menu and select the Paste command. 
 
• Switch back to the first document (by clicking on its icon at the bottom of the 

screen). 
 
 
 

3.4.2.4 Move a picture, image, chart within a document, to another 
document. 
 
 

Moving a graphic within a document 
• Select the picture of the police car. 
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• Click on the Edit drop down menu and select the Cut command. 
• Click within the document at the location where you wish to move the 

graphic. 
• Click on the Edit drop down menu and select the Paste command. 
 
 

Moving a graphic between open documents 
• Select the picture of the Chain Saw. 

 

 
 
• Click on the Edit drop down menu and select the Cut command. 
• Switch to the second document where you wish to move the selected graphic. 
• Click within the second document at the location to which you wish to move 

the graphic. 
• Click on the Edit drop down menu and select the Paste command. 
 

3.4.2.5 Resize a picture, image, chart. 
 
 

Resizing a graphic within a document 
• Within the second document select the picture of the chain saw. Move the 

mouse pointer to one corner of the selected graphic, until the mouse pointer 
changes to a line at 45 degrees with an arrowhead at each end. Depress the 
mouse button and drag to resize the image within the document. Release the 
mouse button. Experiment! 

• Right click on the picture of the chain saw and select the Format Picture 
command. The Format Picture dialog box will be displayed. Select the Size 
tab and experiment with changing the size of the picture using exact 
measurements. 

 

3.4.2.6 Delete a picture, image, chart. 
 
 

Deleting an image 
• Switch back to the first document. 
• Experiment with selecting an object and pressing the Del key to delete the 

object. In each case immediately use the Undo icon to reverse the deletion.  
• Save your changes to both documents and close both documents. 
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3.5 Mail Merge  
 
 

3.5.1 Concept and Practice  
 
 

3.5.1.1 Understand the term mail merge and the concept of merging a 
data source with a main document such as a letter or a label document. 
 
 

What is Mail Merging? 
• The Mail Merge feature is used to insert variable data into a fixed format by 

combining two files into one file. Two files need to be created before you can 
merge them, these are the data file and the main document file. The variable 
information, such as names and addresses, is stored in the data file ready to 
merge into the main document file. The information which remains constant 
and the field names are stored in the main document file, where each field 
name relates to a field name in the data file. The data in the two files is 
merged as a series of personalised letters or envelopes. 
 

 
 
 
 

3.5.1.2 Open, prepare a main document for a mail merge by inserting 
data fields.  
 
 

Creating a new main document and merging to a personalised letter 
• Click on the New icon to create a new document. 
• Click on the Tools drop down menu and select the Letters and Mailing 

command.  
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• From the submenu select Mail Merge Wizard. 
 

 
 
• You need to select a document type, such as Letters. 

 

 
 

• To continue, click on the Next link at the bottom-right on the screen. 
 

 
 
• The next screen allows you to specify which letter to use as the main 

document. In this case we will use the current document. 
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• To continue, click on the Next link at the bottom-right on the screen. 
• The next screen allows you to select a recipient. In this case we will use an 

existing list. 
 

 
 
• To continue, click on the Next link at the bottom-right on the screen. 
• You can then select an existing data file using a dialog box, similar to that 

illustrated below. You may have to change to a different folder. In this case 
we have changed to the My Documents folder, and selected a file called 
MAIL MERGE DATA. 
 

 
 
• Once you have selected a data file, and clicked on the Open button, you may 

see a dialog box, as illustrated below. 
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• If everything appears to be in order, click on the OK button. 
• To continue, click on the Next link at the bottom-right on the screen. The 

next screen allows you to write your letter. 
 

 
• Enter the following text to create a new letter, as illustrated. 

 
There will be a meeting to discuss the new marketing strategy at 2 pm  
next Tuesday. Please confirm that you can attend as soon as possible. 
 
David Smith 
Head of Marketing 
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• We have now created the body text of our letter, next we need to add the 

fields which will personalise the document.  
• Click at the top of the document at the location you would wish to insert the 

name and contact details of the person to whom the document will be sent. If 
you look at the right of the screen you will see the following. 
 

 
 
• Click on More Items and you will see the following dialog box displayed (the 

information in this dialog box comes from our Data file). 
 

 
• Click on Title and then click on the Insert button. Click on the Close button. 
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• Press the spacebar (to insert a space). 
 
• Click on More Items once again. 
• Click on firstname and then click on the Insert button. Click on the Close 

button. 
• Press the spacebar (to insert a space). 
 
• Click on More Items once again. 
• Click on secondname and then click on the Insert button. Click on the 

Close button. 
• Press the return key (to insert a paragraph space). 
 
• Click on More Items once again. 
• Click on Department and then click on the Insert button. Click on the Close 

button. 
• Press the return key (to insert a paragraph space) and the document should 

now look like this. 
 

 
 
• Click on the Next link to continue. 

 

 
 
• The screen will display the following details of a letter addressed to 'recipient 

1'. 
 

 
 
• To see other recipients, click on the double arrow pointing to the right. 

 

 
 
• Click on the Next link to continue. 
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• The next screen displays the following message in the task pane. 

 

 
 
• To print all the personalised letters we would click on Print. In this case, 

however, to save paper, we will click on the Edit individual letters link 
which will merge the document with the data file and create a new large 
document containing all the individually addressed letters. When you click on 
this link you will see the following dialog box displayed. 
 

 
 
• Click All and then click on the OK button. You will then see the following. A 

new document containing all the merged letters. 
 

 
 
• If you scroll through this document you will see it is made up of many pages, 

each addressed to a different person. 
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• Save this new document using the file name MY MERGED LETTER. 
• Close all open documents without saving your changes. 
 
 
 

3.5.1.3 Open, prepare a mailing list, other data file, for use in a mail 
merge. 
 
 

Creating a mailing list, data file. 
• Create a new document 
• Insert a table containing 4 columns and 7 rows (use the Insert Table icon). 

 
 

 
• Enter the following data into the table. 

 

 
 
• Click within the table. 
• Click on the Table drop down menu and select the Convert command. From 

the submenu displayed, select Table to Text. In the dialog box displayed, 
select Tabs, and click on the OK button. This will convert the table to a 
format, where the data fields are separated by tabs. This type of format is 
called a tab delimited format (delimited means separated). 
 

 
 
• We need to save the file as a text only formatted file. To do this click on the 

Save icon, and enter a file name, such as MY DATA FILE. Click on the down 
arrow to the right of the Save as type box and select Plain Text. Click on 
the Save button to save the file. 

• The File Conversion dialog box will be displayed, click on the OK button. 
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3.5.1.4 Merge a mailing list with a letter, label document. 
 
 

Mail merging to labels 
• In the section 3.5.1.2, we mail merged to a letter. If you wish to mail merge 

to a label, the process is largely the same, except that in the first Mail Marge 
Helper screen, you need to select Mailing Labels, rather than Form 
Letters. Later in the merge process you will be asked to select the type of 
label required, as illustrated. For practice we will perform this mail merge 
step-by-step. 

 
• Close any documents which may be open. 
• Click on the New icon to create a new document. 
• Click on the Tools drop down menu and select the Letters and Mailings 

command.  
• From the submenu select Mail Merge Wizard. 

 

 
 

• MAIL MERGE STEP 1 OF 6: - SELECT DOCUMENT TYPE 
You need to select a document type, such as Labels. 
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• To continue, click on the Next link at the bottom-right on the screen. 
 

 
 
• MAIL MERGE STEP 2 OF 6: - SELECT STARTING DOCUMENT  

The next screen allows you to specify the starting document. In this case we 
will use the current document by selecting the Change document layout 
option. 
 

 
 

• MAIL MERGE STEP 2 OF 6: - CHANGE DOCUMENT LAYOUT 
In the Change Document Layout section of the Task Pane, click on the 
Label options link. This will display the Label Options dialog box. 
 

 
 

• In the Label products section use the drop down arrow to the right to select 
the manufacturer of the labels which you are using. 
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NOTE: In Europe, if you are using Avery products, be sure to select Avery 
A4 and A5 sizes. Avery standard relates to standard US sizes! 

 
• If using European Labels (be sure to first select Avery A4 and A5 sizes in 

the Label products section), select Product number J8163 - Address as 
illustrated below. 
 

 
 

• Click on the OK button to close the Label Options dialog box. 
• When you close the dialog box, you will see a representation of the labels on 

your screen, as illustrated below. 
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• To continue, click on the Next link at the bottom-right on the screen. 
 
• MAIL MERGE STEP 3 OF 6: - SELECT RECIPIENTS  

Within the Section recipients section of the task pane, you can select a 
recipient. In this case we will use an existing list. 
 

 
 
• MAIL MERGE STEP 3 OF 6: - USE AN EXISTING LIST 

Within the Use an existing list section of the task pane, click on the 
Browse icon which will display a dialog box. In this case select a file called 
MAIL MERGE DATA, as illustrated. 
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• Click on the Open button and a new dialog box will be displayed as illustrated 

below. 
 

 
 
• In this case click on the OK button to continue. 
• To continue, click on the Next link at the bottom-right on the screen. 
 
• MAIL MERGE STEP 4 OF 6: - ARRANGE YOUR LABELS 

You will see the following displayed in the Task Pane. 



PAGE 66 - ECDL MODULE 3 WORKBOOK (USING OFFICE XP) 

FOR USE AT THE LICENSED SITE(S) ONLY 
© Cheltenham Courseware Ltd. 1995-2005 www.cheltenhamcourseware.com 

 

 
 
• Click on the More items links to enable you to insert items relating to the 

particular database you are using as your data source. This will display a 
dialog box as illustrated, 
 

 
 
• Click on the first item, i.e. Title.  
• Click on the Insert button, and then click on the Close button. 
• Press the spacebar to insert a space. 
 
• Click on the More Items link to reopen the dialog box.  
• Click on the second item, i.e. Firstname.  
• Click on the Insert button, and then click on the Close button. 
• Press the spacebar to insert a space. 
 
• Click on the More Items link to reopen the dialog box. 
• Click on the third item, i.e. Secondname.  
• Click on the Insert button, and then click on the Close button. 
• Press the Return key to insert a paragraph. 
 
• Click on the More Items link to reopen the dialog box. 
• Click on the last item, i.e. Department.  
• Click on the Insert button, and then click on the Close button. 
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• The first label should now look like this. 
 

 
 
• MAIL MERGE STEP 4 OF 6: - REPLICATE LABELS 

In the lower part of the task pane you will see the following. 
 

 
 
• Click on the Update all labels button and you will see the following. 

 

 
 

• To continue, click on the Next link at the bottom-right on the screen. 
 
• MAIL MERGE STEP 5 OF 6: - PREVIEW YOUR LABELS 

You will see the following displayed within the task pane. 
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• You can click on the right pointing arrow to preview the labels. In this case 
we will click on the Next link to continue. 

 
• MAIL MERGE STEP 6 OF 6: - PREVIEW YOUR LABELS 

You will see the following displayed within the Task Pane. 
 

 
 
• If you wanted to print directly to a printer you would click on the Print link. 

In this case we will output the merged information to a new document (which 
could be printed later), by clicking on the Edit individual labels link. A 
dialog box will be displayed, click on the OK button. 
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• A new document will be created, as illustrated below. 
 

 
 
• Save this file and call the file MY MERGED LABELS. 
• Close any other open files, without saving any changes. 
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3.6 Prepare Outputs 
 
 

3.6.1 Preparation  
 
 

3.6.1.1 Understand the importance of proofing your document such as: 
checking the layout, presentation (margins, appropriate font sizes and 
formats) and spelling. 
 
 

Manually checking your work 
• Open a document called PREPARATION.  
• As you can see this document is a mess! Read through the document and 

manually correct all the mistakes which you find. 
• Click on the Print Preview icon to see what the document would look like if 

printed. Close the Print preview view. 
• Click on the File drop down menu and select the Page Setup command. 

Make sure that the Margins tab is displayed. In the Orientation section of 
the dialog box, select Portrait and click OK to close the dialog box. 
 

 
 
• Click on the Print Preview icon to see what the document would now look 

like if printed. Close the Print Preview view. 
 
• Save your changes and close the file. 
 
 
 

3.6.1.2 Spell-check a document and make changes such as correcting 
spelling errors, deleting repeated words. 
 
 

Spell Checking your documents 
• Open a document called SPELLING.  
• Click on the Spelling icon in the Standard toolbar (or press F7). This will 

allow you to check your document. Follow the on-screen prompts. 
 

 
 
• Save your changes and close the file. 
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3.6.1.3 Add words to a built-in custom dictionary. 
 
 

Adding a word to the custom dictionary 
• Open a document called UNKNOWN.  
• Press F7 to start the spell checker program. It will highlight the company 

name at the end of the letter. If this were your company's name, then you 
could add this to the computers list of correctly spelt words, so that in future, 
this word would not be highlighted as unrecognised by the spell checker. In 
this case DO NOT click on the Add to dictionary button to add the word to 
the dictionary. 

• Save your changes and close the file. 
 
 
 

3.6.1.4 Preview a document. 
 
 

Previewing a document 
• Open a document called PRINTING.  
• Click on the Print Preview icon. The Print Preview screen appears. 
• Click once in the document and the mouse cursor will change to a Zoom tool. 
• Click on the document again to view it more closely and click again to zoom 

back out. 
 

 
• View all the pages within the document. 
• Close the Print Preview view. 

 
  

 

3.6.2 Printing 
 
 

3.6.2.1 Choose print output options such as: entire document, specific 
pages, number of copies. 
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Specify what to print 
• Click on the File drop down menu and select the Print command.  

 

 
 
Make changes as required within the Page range section of the dialog box. 
In this case, enter 2 so that only page 2 is printed. 
 

 
 
 

Specifying the number of copies required 
• Within the Copies section of the dialog box enter the number of copies 

required, in this case 2 (so that 2 copies will be printed). 
 

 
 
 
 

3.6.2.2 Print a document from an installed printer using defined options, 
default settings. 
 
 

Printing a document 
• Following on from the previous exercises, click on the OK button and 2 copies 

of page 2 will be printed. 



PAGE 73 - ECDL MODULE 3 WORKBOOK (USING OFFICE XP) 

FOR USE AT THE LICENSED SITE(S) ONLY 
© Cheltenham Courseware Ltd. 1995-2005 www.cheltenhamcourseware.com 

 

 
 
 

Investigating the installed printers 
• From the File menu, choose the Print command to display the Print dialog 

box. 
• Click on the down arrow to the right of the Name section of the Printer dialog 

box, and select the required printer. This list you see will depend on how your 
IT Support people have set up your computer. 
 

 
 
 

Printing to the default printer 
• Clicking on the Print icon will print all pages in the current document to the 

default printer. Try it now. 
• Close any open files without saving any changes which you may have made. 
 
 


